
Chapter 1

Meeting Google SketchUp
In This Chapter
▶ Finding out why it’s free from Google

▶ Comparing SketchUp with other 3D software

▶ Finding out what you can and can’t do with SketchUp

▶ Looking around the application

Once upon a time, software for building three-dimensional (3D) models 

of thing like buildings, cars, and other stuff was hard to use. I mean 

really hard — people went to school for years to learn it. And if that wasn’t 

bad enough, 3D modeling software was expensive. It was so expensive that 

the only people who used it were professionals and software pirates (people 

who stole it, basically). Then along came SketchUp.

Operating under the assumption that lots of people might want — and need — 

to make 3D models, the folks who invented SketchUp decided to design a 

program that worked more intuitively. Instead of making you think about 3D 

models as complex mathematical constructs (the way computers think), they 

created an interface that lets you build models using elements you’re already 

familiar with: lines and shapes.

So do you need to know how to draw to use SketchUp? In the latest version of 

the software, not really. Traditional drawing is about translating what you see 

onto a flat piece of paper: going from 3D to 2D, which is hard to do for most 

people. In SketchUp, you’re always in 3D, so no translation is involved — you 

just build, and SketchUp takes care of stuff like perspective and shading for you.

This first chapter is about putting SketchUp in context: why Google offers it 

for free, how it compares to other 3D software, and what you can (and can’t) 

do with it. In the last part of the chapter, I give a quick tour of the program, 

just to let you know where things are.
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12 Part I: Getting Started with SketchUp 

Things You Ought to Know Right Away
Before I continue, here’s some information you might need:

 ✓ You get SketchUp by downloading it from the Internet. Just type 

http://sketchup.google.com into your Web browser and read 

through the first page of the Google SketchUp Web site. Click the links 

to download the application to your computer, and then follow the 

installation instructions on the Web.

 ✓ SketchUp works in Windows and Mac OS X. Google SketchUp is 

available for both operating systems, and it looks (and works) about 

the same way on both.

 ✓ A Pro version is available. Google offers a Pro version of SketchUp 

(called Google SketchUp Pro) that you can buy if you need it. It includes 

a few terrific features that folks like architects, production designers, 

and other design professionals need for exchanging files with other 

software. SketchUp Pro also includes a whole separate application 

for creating presentation documents with your SketchUp models. It’s 

called LayOut, and it’s the subject of Chapter 14. If you think you might 

need Pro, you can download a free trial version at http://sketchup.
google.com.

Where SketchUp Fits in Google’s World
A long time ago, somebody invented photography (hey — this isn’t a history 

book), and all of a sudden there was a way to make pictures of things that 

didn’t involve drawing, engraving, or painting. Nowadays, you can’t throw 

a rock without hitting a photograph of something. Everything (it seems) can 

take pictures, including people’s phones. Photography is the main way that 

visual information is communicated.

But what comes after photography? Google (and just about every science-

fiction writer who ever lived) thinks it’s 3D, and here’s why: You live in 3D. 

The furniture you buy (or build) is 3D, and so is the route you take to work. 

Because so many of the decisions you need to make (buying a couch, finding 

your way) involve 3D information, wouldn’t it be nice to be able to experience 

that information in 3D?

Software like SketchUp lets you see 3D information on a 2D screen, which is 

good, but affordable 3D printers and holography (yep, holograms) are just 

over the horizon. All that’s left is to build a model of every single thing in the 

world — and guess who’s going to do it?
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You. By making SketchUp free for everyone, Google is leading the 3D charge. 

Rather than relying on a small number of 3D nerds to get around to modeling 

everything in the universe, Google made SketchUp available to anyone who 

wants to participate. After all, Google is about organizing the world’s informa-

tion — not creating it. By giving SketchUp away, the company has created a 

whole new kind of information to organize. Chapter 11 is all about SketchUp 

and Google Earth, as well as the Google 3D Warehouse, where the world’s 3D 

information is being stored — at least for now.

Comparing SketchUp to Other 
3D Modeling Programs

If you’re reading this book, I presume you’re at least interested in two things: 

building 3D models and using SketchUp to do so. The following sections 

tell you something about how SketchUp compares to other 3D modeling 

programs — how long it takes to figure out how to use it and what kind of 

models it produces.

Jumping right in
When it comes to widely available 3D modeling software, it really doesn’t get 

any easier than SketchUp. This software has been as successful as it has for 

one reason, and it has everything to do with how quickly people are able to 

get good enough at SketchUp to build something within a couple of hours of 

launching it for the first time. You have no thick manuals to read, no special 

geometric concepts to understand; modeling in SketchUp is about grabbing 

your mouse and making something.

So how long should it take you to discover how it works? It depends on your 

background and experience, but in general, you can expect to be able to 

make something recognizable in under four hours. That’s not to say you’ll be 

a whiz — it just means that SketchUp’s learning curve is extremely favorable. 

You don’t need to know much to get started, and you’ll still be picking things 

up years from now. In fact, I’ve learned a couple of things just writing this 

book.

But is SketchUp easy? Lots of people say so, but I think it’s all relative. 

SketchUp is without a doubt easier than any other modeling program I’ve 

tried, but 3D modeling itself can be tricky. Some people catch on right away, 

and some folks take longer. But I can say this for sure: If you want to build 3D 

models, and you have an afternoon to spare, there’s no better place to start 

than SketchUp.
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Understanding the difference 
between paper and clay
Three-dimensional modeling software comes in two basic flavors: solids and 
surfaces. Figure 1-1 and the following points illustrate the difference:

 

Figure 1-1: 
SketchUp 

models are 
hollow.

 

Surface models are hollow Solid models are solid

 ✓ SketchUp is a surfaces modeler. Everything in SketchUp is basically 

made up of thin (infinitely thin, actually) surfaces — these are called 

faces. Even things that look thick (like cinder-block walls) are actually 

hollow shells. Making models in SketchUp is a lot like building things out 

of paper — really, really thin paper.

  Surface modelers like SketchUp are great for making models quickly, 

because all you really need to worry about is modeling what things look 

like. That’s not to say that they’re less capable; it’s just that they’re 

primarily intended for visualization.

 ✓ Using a solids modeler is more like working with clay. When you cut 

a solid model in half, you create new surfaces where you cut; that’s 

because objects are, well, solid. Programs like SolidWorks, Form●Z, and 

Inventor create solid models.

  People who make parts — like mechanical engineers and industrial 

designers — tend to work with solid models because they can use 

them to do some pretty precise calculations. Being able to calculate the 

volume of an object means that you can figure how much it will weigh, 

for example. Also, special machines can produce real-life prototypes 

directly from a solid-model file. These prototypes are handy for seeing 

how lots of little things are going to fit together.

An important point to reinforce here is that there’s no “best” type of model-

ing software. It all depends on three things: how you like to work, what you’re 

modeling, and what you plan to do with your model when it’s done.
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 When I said (a few paragraphs ago) that 3D modeling programs come in two 

basic flavors, I sort of lied. The truth is, you can split them into two groups 

another way as well: by the kind of math they use to produce 3D models. You 

can find polygonal modelers (of which SketchUp is an example) and curves-
based modelers. The former type uses straight lines and flat surfaces to define 

everything — even things that look curvy, aren’t. The latter kind of modeler 

uses true curves to define lines and surfaces. These yield organic, flowing 

forms that are much more realistic than those produced by polygonal modelers, 

but that put a lot more strain on the computers that have to run them — and 

the people who have to figure out how to use them. Ultimately, it’s a trade-off 

between simplicity and realism.

What You Should (and Shouldn’t) 
Expect SketchUp to Do

Have you ever been to a hardware store and noticed the “multitool” gizmos 

on the racks next to the checkout stands? I once saw one that was a combina-

tion screwdriver, pliers, saw, tape measure, and (I swear) hammer. I some-

times wonder whether the hardware-store people put them there as a joke, 

just to make you feel better about standing in line.

I generally don’t like tools that claim to be able to do everything. I much 

prefer specialists — tools that are designed for doing one thing really well. In 

the case of SketchUp, that one thing is building 3D models. 

Here’s a list of things (all model-building-related) that you can do with 

SketchUp:

 ✓ Start a model in lots of different ways: With SketchUp, you can begin a 

model in whatever way makes sense for what you’re building:

 • From scratch: When you first launch SketchUp, you see nothing 

except a little person standing in the middle of your screen. If you 

want, you can even delete him, leaving you a completely blank 

slate on which to model anything you want.

 • In Google Earth: Chapter 11 goes into this in detail. Basically, you 

can bring an aerial photograph of any place on Earth (including 

your home) into SketchUp and start modeling right on top of it.

 • From a photograph: The second part of Chapter 8 talks all about 

how you can use SketchUp to build a model based on a photo of 

the thing you want to build. It’s not really a beginner-level feature, 

but it’s there.
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 • With another computer file: SketchUp can import images and 

CAD (computer-aided drawing) files so that you can use them as a 

starting point for what you want to make.

 ✓ Work loose or work tight: One of my favorite things about SketchUp is 

that you can model without worrying about exactly how big something 

is. You can make models that are super-sketchy, but if you want, you can 

also make models that are absolutely precise. SketchUp is just like paper 

in that way; the amount of detail you add is entirely up to you.

 ✓ Build something real or make something up: What you build with 

SketchUp really isn’t the issue. You only work with lines and shapes — 

in SketchUp, they’re called edges and faces — so how you arrange them 

is your business. SketchUp isn’t intended for making buildings any more 

than it is for creating other things. It’s just a tool for drawing in three 

dimensions.

 ✓ Share your models: After you’ve made something you want to show off, 

you can do a number of things, which you can discover in detail in Part IV:

 • Print: Yep, you can print from SketchUp.

 • Export images: If you want to generate an image file of a particular 

view, you can export one in any of several popular formats.

 • Export movies: Animations are a great way to present three-

dimensional information, and SketchUp can create them easily.

Is it a toaster or a bungalow?
SketchUp models are made from two basic 
kinds of geometry: edges (which are straight 
lines) and faces (which are 2D surfaces bound 
by edges). That’s it. When you use SketchUp to 
draw a bunch of edges and faces in the shape 
of a staircase, all SketchUp knows is how many 
edges and faces it has to keep track of, and 
where they all go. There’s no such thing as a 
stair in SketchUp — just edges and faces.

That said, there’s a brand new development 
in SketchUp 7: Dynamic Components are pre-
programmed objects that know what they are. A 
dynamic staircase, for example, is smart enough 
to know that it should add or subtract steps 
when you make it bigger or smaller. Dynamic 
Components are a big step for SketchUp; 
all of a sudden, there’s a class of stuff in the 

program that has (what software types would call) 
intelligence. What’s that mean for you? For 
starters, SketchUp is easier to pick up than 
it’s ever been. I go on and on about Dynamic 
Components in Chapter 5.

With the exception of Dynamic Components, 
though, things in SketchUp don’t have any idea 
what they’re supposed to represent. Coming to 
this realization has the tendency to freak some 
people out. If you want a model of something, 
you have to make it out of edges and faces. The 
thing to remember is that SketchUp was created 
to let you model anything, not just buildings, so 
its tools are designed to manipulate geometry. 
That’s good news, believe it or not, because it 
means that you’re not restricted in any way; you 
can model anything you can imagine.
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 • Export other 3D model formats: With the Pro version of SketchUp, 

you can share your model with other pieces of software to create 

CAD drawings, generate photorealistic renderings, and more.

 • Upload to the 3D Warehouse: This is a giant, online repository of 

SketchUp models that you can add to (and take from) all you want.

What can’t SketchUp do? A few things, actually — but that’s okay. SketchUp 

was designed from the outset to be the friendliest, fastest, and most useful 

modeler available — and that’s it, really. Fantastic programs are available 

that do the things in the following list, and SketchUp can exchange files with 

most of them:

 ✓ Photorealistic rendering: Most 3D modelers have their own, built-in 

photo renderers, but creating model views that look like photographs 

is a pretty specialized undertaking. SketchUp has always focused on 

something called nonphotorealistic rendering (NPR) instead. NPR (as it’s 

known) is essentially technology that makes things look hand-drawn — sort 

of the opposite of photorealism. If you want to make realistic views of 

your models, I talk about some renderers that work great with SketchUp 

in Chapter 16.

 ✓ Animation: A few paragraphs ago, I mentioned that SketchUp can export 

animations, but that’s a different thing. The movies that you can make 

with SketchUp involve moving your “camera” around your model. True 

animation software lets you move the things inside your model around. 

SketchUp doesn’t do that, but the Pro version lets you export to a 

number of different programs that do.

Taking the Ten-Minute SketchUp Tour
The point of this portion of the chapter is to show you where everything is — 

kind of like the way a parent shows a new babysitter around the house before 

leaving for a couple of hours. It’s not meant to explain what anything does, 
per se. I just want you to feel like you know where to start looking when you 

find yourself hunting around for something.

Just like most programs you already use, SketchUp has five main parts. 

Figure 1-2 shows all of them, in both the Windows and Mac versions of the 

program. I describe these parts, plus an additional feature, in the following 

list:

 ✓ Modeling window: See the big area in the middle of your computer 

screen? That’s your modeling window, and it’s where you spend 

99 percent of your time in SketchUp. You build your model there; it’s 

sort of a frame into a 3D world inside your computer. What you see in 

your modeling window is always a 3D view of your model, even if you 

happen to be looking at it from the top or side.
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 ✓ Menu bar: For anyone who has used a computer in the last 30 years, 

the menu bar is nothing new. Each menu contains a long list of options, 

commands, tools, settings, and other goodies that pertain to just about 

everything you do in SketchUp.

 ✓ Toolbars: These contain buttons that you can click to activate tools and 

commands; they are faster than using the menu bar. SketchUp has a few 

different toolbars, but only one is visible when you launch it the first 

time: the Getting Started toolbar.

  If your modeling window is too narrow to show all the tools on the 

Getting Started toolbar, you can click the arrow on the right to see the 

rest of them.

 ✓ Dialog boxes: Some programs call them palettes and some call them 

inspectors; SketchUp doesn’t call them anything. Its documentation 

(the SketchUp Help document you can get to in the Help menu) refers to 

some of them as managers and some as dialog boxes, but I thought I’d 

keep things simple and just call them all the same thing: dialog boxes.

 ✓ Status bar: You can consider this your SketchUp dashboard, I suppose. 

It contains contextual information you use while you’re modeling.

 ✓ Context menus: Right-clicking things in your modeling window usually 

causes a context menu of commands and options to open. These are 

always relevant to whatever you happen to right-click (and whatever 

you’re doing at the time), so the contents of each context menu are 

different.

 

Figure 1-2: 
All of 

SketchUp’s 
parts: in 

Windows 
(left) and on 

the Mac.

 

Dialog boxMenu bar

Getting Started toolbar

Modeling window Status bar
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 Although the following items aren’t part of the SketchUp user interface (all the 

stuff I just listed in the previous list), they’re a critical part of modeling in 

SketchUp:

 ✓ A mouse with a scroll wheel: You usually find a left button (the one you 

use all the time), a right button (the one that opens the context menus), 

and a center scroll wheel that you both roll back and forth and click 

down like a button. You should get one if you don’t already have one — 

it’ll improve your SketchUp experience more than any single other thing 

you could buy.

 ✓ A keyboard: This sounds silly, but some people have tried to use 

SketchUp without one; it’s just not possible. So many of the things you 

need to do all the time (like make copies) involve your keyboard, so 

you’d better have one handy if you’re planning to use SketchUp.

Hanging out at the menu bar
SketchUp’s menus are a pretty straightforward affair; you won’t find anything 

surprising like “Launch Rocket” in any of them, unfortunately. All the same, 

here’s what they contain:

 ✓ File: Includes options for creating, opening, and saving SketchUp files. 

It’s also where to go if you want to import or export a file, or make a 

printout of your model view.

 ✓ Edit: Has all the commands that affect the bits of your model that are 

selected.

 ✓ View: This one’s a little tricky. You’d think it would contain all the 

options for flying around in 3D space, but it doesn’t — that stuff’s on the 

Camera menu. Instead, the View menu includes all the controls you use 

to affect the appearance of your model itself: what’s visible, how faces 

look, and so on. View also contains settings for turning on and off certain 

elements of SketchUp’s user interface.

 ✓ Camera: Contains controls for viewing your model from different angles. 

In SketchUp, your “camera” is your point of view, literally.

 ✓ Draw: Includes tools for drawing edges and faces in your modeling 

window.

 ✓ Tools: Most of SketchUp’s tools are contained here, except of course for 

the ones you use for drawing.

 ✓ Window: If you’re ever wondering where to find a dialog box you want 

to use, this is the place to look; they’re all right here.
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 ✓ Plugins: You can get extra tools for SketchUp — little programs that 

“plug in” to it and add functionality. Some of them show up here after 

they’re installed. Chapter 16 has some information on these.

 ✓ Help: When you’re stuck, and this book isn’t helping (heaven forbid), 

check out the Help menu. It’s the gateway to SketchUp salvation.

Checking the status bar
Even though the big part in the middle is the most obvious part, there’s 

plenty more to the modeling window that you should know about:

 ✓ Context-specific instructions: Most of the time, you check here to see 

what options might be available for whatever you’re doing. Modifier 

keys (keyboard strokes that you use in combination with certain tools 

to perform additional functions), step-by-step instructions, and general 

information about what you’re doing all show up in one place: right 

here.

 ✓ The Measurements box: The Measurements box is where numbers 

show up (to put it as simply as I can). Chapter 2 goes into more detail 

about it, but the basic purpose of the Measurements box is to allow you 

to be precise while you’re modeling.

Where are all the tools?
The Getting Started toolbar contains a small 
subset of the tools that you can use in SketchUp. 
The thinking (which I agree with, incidentally) 
is that seeing all the tools right away tends 
to overwhelm new users, so having a limited 
selection helps people out.

To get access to more tools (through toolbars, 
anyway — you can always access everything 
through the menus), you do different things, 
depending on which operating system you’re 
using:

 ✓ Windows: Choose View➪Toolbars. The 
mother lode! I recommend starting off with 
the Large Tool Set to begin with, and then 
adding toolbars as you need them (and as 
you figure out what they do).

 ✓ Mac: Choose View➪Tool Palettes➪Large 
Tool Set. To add even more tools, right-click 
the Getting Started toolbar (the one right 
above your modeling window) and choose 
Customize Toolbar. Now drag whatever 
tools you want onto your toolbar, and click 
the Done button.
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 ✓ Status indicator icons: SketchUp 7 has three little icons that appear in 

the lower-left corner of your screen. They change to tell you things 

about your model, and you can click them to find out what they do. The 

most important one to note (this early on in your SketchUp tutelage) is 

the one that looks like a question mark. When you click it, it opens the 

Instructor dialog box, which contains information about the tool you’re 

currently using.

Taking a peek at the dialog boxes
Most graphics programs have a ton of little controller boxes that float around 

your screen, and SketchUp is no exception. After the dialog boxes are open, 

you can “dock” them together by moving them close to each other, but most 

people I know end up with them all over the place — me included. Dialog 

boxes in SketchUp contain controls for all kinds of things; here are some of 

the ones that I think deserve special attention:

 ✓ Preferences: While the Model Info dialog box (see the next point) 

contains settings for the SketchUp file you have open right now, the 

Preferences dialog box has controls for how SketchUp behaves no 
matter what file you have open. Pay particular attention to the Shortcuts 

panel, where you can set up keyboard shortcuts for any tool or com-

mand in the program.

  On the Mac, the Preferences dialog box is on the SketchUp menu, which 

doesn’t exist in the Windows version of SketchUp.

  Some changes to the Preference settings don’t take effect until you open 

another file or restart SketchUp altogether, so don’t worry if you can’t 

see a difference right away.

 ✓ Model Info: This dialog box is, to quote the bard, the mother of all 

dialog boxes. It has controls for everything under the sun; you should 

definitely open it and take your time going through it. Chances are, the 

next time you can’t find the setting you’re looking for, it’s in Model Info.

 ✓ Entity Info: This little guy is small, but it shows information about 

entities — edges, faces, groups, components, and lots of other things — 

in your model. Keeping it open is a good idea, because it helps you see 

what you have selected.

 ✓ Instructor: The Instructor only does one thing: It shows you how to 

use whatever tool happens to be activated. While you’re discovering 

SketchUp, you should keep the Instructor dialog box open off to the 

side. You can also open it at any time by clicking the little “?” icon in the 

Status bar, at the bottom of your screen.
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